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Introduction 

This section provides a quick overview of the main screens and features you will find in 
Merriam-Webster's Collegiate Dictionary and Thesaurus, and it provides an introduction to the 
main components of the program. More detailed explanations of the features of the dictionary 
and thesaurus can be found the later sections of the program's Help system. 
These instructions assume you have a basic understanding of how to use your Windows or 
Macintosh computer and that you are familiar with basic navigation terms such as "double-click"
and "scroll." If you need help with these aspects of using your computer, consult the manuals that
came with it.



Types of information in the dictionary 

Dictionary entries pack a lot of information into a very limited space. You can use the dictionary 
more effectively if you know what kinds of information are included in dictionary entries and 
how they are organized. The illustration below introduces the key elements of a dictionary entry. 
Detailed information about the structure of the entries in this dictionary can be found in a PDF 
called "Collegiate Dictionary Explanatory Notes" that can be found on the CD-ROM. 



Dictionary overview 

The dictionary's features are organized to look up words, view results, and use the results of 
searches. All of the features you need to use the program can be found in the Main Window of 
the program, which is shown below. 
Each component of the Main Window enables you to accomplish certain tasks with the program. 
The table below summarizes the parts of the Main Window and tells briefly what you can do 
with each element in it. 

 
 
Menu bar:     
The Menu Bar appears at the top of the screen and lets you access all of the program features 
using either your mouse or keyboard. 
To use the keyboard to access Menu Bar items, look for the underlined letters in the name of the
menu element you want. To access any menu item, hold down the ALT key (Win) or Command 
key (Mac), then press the underlined letter in the menu name, followed by the underline letter of 
the menu item you want. 
For example, to bookmark a word, you would type ALT (or Command) + B + A. 
 
Navigation area:  
This part of the screen includes the Back and Forward buttons and the reference selection drop-
down menu that you can use to change which reference you are searching (if you have more than
one Merriam-Webster reference installed). 
 
Search Tabs:  
The three tabs below the Navigation area let you switch between the Basic Searches, Advanced 
searches, and Browse search screens. 



 
Search input area:  
This area includes theSearch Type drop-down menu, which you can use to choose the type of 
search you want to perform. It also has an Search Input box where you can type the word or 
phrase you want to look up, as well as Search, Clear, and Spelling Help buttons to use when 
searching. See the section Looking up a word for more details. 
 
Results/Lookup list area:  
When you are typing a term to look up, this area shows a list of words that contain the letters you
have already typed. After you click Search, this area will show the results of the dictionary or 
thesaurus search for the word or phrase in the Search Input box. See the section Using the 
Results/Lookup List for more information. 
 
Entry display area:  
This area on the right side of the screen shows the dictionary or thesaurus entry for the word or 
phrase highlighted in the Results/LookupList. Dictionary entries that have audio pronunciations
are highlighted in blue in the Entry display area. 
 
Status bar:  
This area at the bottom of the screen shows how many words have been found by your search 
and provides brief help messages as you move your cursor over the program screen. 
 
Illustrations:  
Dictionary entries that have illustrations are marked with an eye-shaped icon. Double-click on 
the icon to see the illustration. Note that illustrations will appear in their own window. 
 
Go Online:  
The Go Online menu lets you access web-based resources.



Looking up a word 

It is very easy to look up a word using this program. Just follow these instructions: 
      1.      Choose the refernce you want to search from the Search Type drop-down menu.

      2.      Type the word or phrase you want to look up in the Search Input box.

      3.      Click Search (or press ENTER/RETURN).
These instructions allow you to look up a boldfaced word in the dictionary or thesaurus in much 
the same way you would look up a word in a printed reference. 

You can even look up several words at once. Simply enter all of the words you want to look up in
a list with commas separating the words. For example, if you want to look up the entries for the 
words "cat" and "bird," type "cat, bird" (without quotation marks) in the input box and click 
Search. The Results List will show the entries for the last word in your list of terms. To see the 
Results List for the other words, use the Back button directly above the list area. 

See the section Entry word searches for more details on looking up words.



Using the results/lookup list 

Lookup list:  
When you start to type a word or phrase in the  Search Input box, a list of words appears in the 
Results/Lookup area showing you terms that begin with the letters you have already typed. If 
you see the word you want in the list, double-click on it to search for it. You can also browse this 
list for words that are alphabetically near the one you are typing. 
 
Results list:  
After you click on the Search button, the Results List appears in the lower left part of the 
screen. It displays all entries containing the word you typed in the input box, including 
homographs (that is, words that are spelled alike but that have different origins or parts of 
speech); it also shows phrases and compound terms containing the word. The entry for the first 
term in the Results List displays automatically after you run a search. To see the entry for any 
other word in the Results List, click on that word. 

You can move through the list by scrolling, using the arrow keys, or using the PAGE UP and 
PAGE DOWN keys. 

You can also return to the results of a previous search using the small Back and Forward 
buttons that appear directly above the Results List. 

Those two buttons work much the way the Back and Forward buttons on a Web browser work. 
Click Back to go back to the Results List for the last search you ran (you can go back through 
several previous searches if you wish). After you have gone back one or more times, click 
Forward to move forward through the sequence of saved search results again.



Moving from one word to the next 

The table below shows various ways to move from one word to another in the dictionary. 



Types of searches 

Merriam-Webster's Collegiate Dictionary offers 15 different types of searches and Merriam-
Webster's Collegiate Thesaurus offers 4 search types that you can use to find information about 
words and language. When you first open the program, it is set to automatically look up the 
boldfaced words that you would look up in a print dictionary; those boldface terms are called 
"entry words." The table below provides a list of the 19 search types and gives a brief description
of the uses of each one. You can find more detailed information about how to perform each 
different type of search in the section titled Using Basic Searches to Look Up Words. 



Menu commands 

The following table describes the menu options that are available in this program. 







Keyboard/mouse-controlled commands 

The following table gives an overview of the program commands for the dictionary. Macintosh 
users should substitute COMMAND for ALT. 



Bookmarking entries 

Merriam-Webster's Collegiate Dictionary & Thesaurus lets you bookmark reference entries from
the dictionary or thesaurus so you can return to them later, in much the same way that you 
bookmark pages on the World Wide Web with a browser. For example, you might create 
bookmarks for vocabulary words you are studying, terms that are commonly confused or 
misused, or words that have a special usage in your school or business. 
 
Adding new bookmarks:  
To create a bookmark, display the entry you want to return to and choose the Add Bookmark 
command from the Bookmarks menu. A submenu will appear showing you all the folders that 
already exist where you can add bookmarks. 
Navigate to the folder where you want the new bookmark added and click on it. 
If you choose to add the new bookmark to the Main Level, the program will add the word below
the line in the Bookmarks menu. Words are added to the menu in the order in which they were 
bookmarked; if you want to rearrange them later, you must use the Organize Bookmarks option
in the Bookmarks menu. 

REMINDER:  You must have an entry showing in the Entry Display pane before you can use 
the Add Bookmark feature. 
 
Organizing your bookmarks:  
To rearrange your bookmarks once they are created, choose Organize Bookmarks from the 
Bookmarks menu (see the illustration below). 



 

To create a new bookmarks folder, position the cursor where you want the new folder to appear 
in the Organize Bookmarks dialog box, then click on the Create New Folder button. Type a 
name for your folder and click OK. Use the Sort button to arrange your bookmarks 
alphabetically; folders will appear at the top of the bookmarks list when you sort them. Use the 
Delete button to remove bookmarks you no longer need.



Customizing the dictionary 

You can customize Merriam-Webster's Collegiate Dictionary & Thesaurus by enlarging or 
reducing the type size or changing the text or background color. You can set a particular search 
tab (Basic Searches, Advanced Searches, or Browse) to appear immediately each time you 
open the program, and choose whether the dictionary or thesaurus opens automatically each time
you launch the program. 

To customize your dictionary, choose Preferences from the Edit menu.

The preferences dialog includes three tabs,  The Appearance tab,    The Reference tab and  
The Browse Search tab Search. Each tab is used to customize a different aspect of the program. 
 



Spelling help 

How can you look up a word if you aren't sure how to spell it? Merriam-Webster's Collegiate 
Dictionary & Thesaurus includes two main features to help you find the correct spelling of 
words so you can locate them more easily, the Word Wheel and the Spelling Help dialog box. 
 
Word wheel:  
When you begin typing a word in the input box, the Word Wheel appears automatically in the 
Results/Lookup List area in the lower left of the screen. It show words that start with the letters 
you have already typed. If you see the word you want in the list, you can stop typing and double-
click on it. The list in the Word Wheel is also scrollable, so you can browse through it to find 
the words you want. 
Spelling Help button:  
If you aren't sure of enough letters in the word to even come close to spelling it properly, you can
use the Spelling Help button, which appears just below the input box (next to the Clear button). 
The Spelling Help system is based on phonetic spellings. That means you can type a word the 
way it sounds, then have the program suggest correctly spelled words that might be the one you 
want. 

To use the Spelling Help feature, type a word the way it sounds, then click Spelling Help. Scan 
through the list of suggested words in the dialog box, and when you see the one you want, 
double-click on it (or highlight it and click OK). 

 

The following table explains the function of the buttons in the Spelling Help dialog box: 



 

 
TRY IT: 
To see how the Spelling Help system works, type the word youthinasia and click Spelling Help. 
When the dialog box opens, double-click the correct spelling of the word, euthanasia, to see its 
entry. 



Illustrations and Tables 

Merriam-Webster's Collegiate Dictionary & Thesaurus includes more than 1,300 full-color 
illustrations and 24 tables.    If an entry has an illustration or table, a icon shaped like an eye (see 
below) will appear after the definitions at the end of dictionary entry text. 

 

If an entry has a table, a table icon (see below) will appear at the end of the entry. 

 

To view either an illustration or table, double-click on the icon for it. The illustration or table will
open in its own window, which you can resize or close independently of the main program 
window. You can also print illustrations or tables by clicking on the printer icon in the upper 
right corner of the window containing it.



Going online 

If you have an Internet connection and a Web browser, the Go Online menu of Merriam-
Webster's Collegiate Dictionary & Thesaurus provides easy access to a wealth of additional 
language-related resources. You can register your Merriam-Webster CD-ROM, search other 
reference resources, find Word of the Day features for students and adults, play word games, read
transcripts of the popular Word for the Wise public radio program, and more. See the section 
Menu commands for a complete list of the online areas included in the Go Online menu. 

To access one of Merriam-Webster's online resources, make sure you have an open Internet 
connection (you can use your local or national ISP, such as America Online). Once you have 
connected to the Internet, choose a feature from the Go Online menu. Your Web browser will 
open and display the Web page you have selected. 
 
TRY IT: 
Check out Merriam-Webster's Word of the Day! Open a connection to the Internet, then choose 
Word of the Day from the Go Online menu. Check it daily for the latest word on words! 



Using Basic Searches to Look Up Words 

Introducing the Basic Searches tab
Entry word searches
Searching for words in definitions
Searching for words in thesaurus word lists
Rhyme and homophone searches in the dictionary
        Rhyme searches
        Homophone searches
Etymology searches in the dictionary
Word game searches
        Crossword puzzle searches
        Jumble searches
        Cryptogram searches
Searching for special information in dictionary or thesaurus entries
        Function label searches in the dictionary or thesaurus
        Usage label/note searches in the dictionary
        Verbal Illustration searches in the dictionary or thesaurus
        Authors Quoted searches in the dictionary
        Synonym paragraph searches in the dictionary
        Usage paragraph searches in the dictionary



Introducing the Basic Searches tab 

Merriam-Webster's Collegiate Dictionary & Thesaurus has three search screens, Basic Searches,
Advanced Searches, and Browse Search, which let you easily find and use the sophisticated 
search tools included with the program. The Basic Searches screen is likely to be the one that 
you will use most often. It appears automatically the first time you open the program and it lets 
you search through the dictionary using any one of the 15 powerful search options or through the
thesaurus using any of 4 search options. 

The procedure for doing any kind of search on the Basic Searches tab is always the same, 
regardless of which kind of search you choose to perform. Simply follow these steps: 
    1.            Select the Basic Searches tab.

    2.            Choose the type of search you want to perform
the Search Type drop-down menu.

    3.            Type the word or phrase you want to look up
in the input box.

    4.            Click Search (or press ENTER/RETURN).

    5.          View the results in the Entry Display
and the Results/Lookup List.

But what if instead of just looking up the meaning of a word, you want to find words that rhyme 
with it? Or you are interested in locating all of the words that originated in Yiddish? Or you want
to find a Shakespeare quote to use in a presenation? The following sections describe how you 
can use the 15 search types available in the dictionary and the 4 search types available in the 
thesaurus to find those kinds of information -- and many others.



Entry word searches in the dictionary and thesaurus 

You can use entry word searches to look up any word that normally appears in boldface type in 
the dictionary or thesaurus; this is the type of search that is most similar to looking up a word in 
a book. 

To do an entry word search, choose Entry word is... from the Search Type drop-down menu, 
type the word or phrase you want to look up, then click Search or press ENTER/RETURN. 

When you do an entry word search , the program finds not only the word you looked up, but also
other entries that include that word in boldface text.    For example, if you look up the word cat, 
the Results List will include all of the homographs for cat as well as compound terms and 
phrases that include the word (e.g., cat-and-mouse,cat-o'nine-tails). 
 
TIP: 
You can use the asterisk ( * ) and question mark ( ? ) wildcard characters to help you look up 
words. See the section Using Wildcard Characters for more details. 



Searching for words in dictionary definitions 

In the dictionary, the "defining text" is the part of the dictionary entry that lists the various 
meanings of the word; in Merriam-Webster's Collegiate Dictionary, definitions are listed in 
chronological order, with the oldest meanings first. 

For more information about the types of information in dictionary definitions, see the PDF titled 
"Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

You can search through defining text to find dictionary entries that include particular words 
within the text of definitions. For example, if you were doing a project on baseball, you might 
want to see all the entries in the dictionary that have to do with that sport (and which therefore 
include the word baseball in their definition). 

To do a defining text search, choose the Defining text contains... option from the Search Type 
drop-down menu, type the word or phrase you want to look up, then click Search or press 
ENTER/RETURN. 
 
TIP: 
When you perform a defining text search, the program will automatically look for inflected 
forms of the search word as well as the base word.    For example, if you do a Defining text 
contains... search for swim, the Results List will include all entries whose definitions contain 
swim, swam, swum, swimming, or swims. 

 
TIP: 
If you see a word in a definition and you aren't sure what it means, double-click on it to see the 
dictionary entry for it. 



Searching for words in thesaurus word lists 

In Merriam-Webster's Collegiate Thesaurus, the Word list contains... search option allows you 
to find the entries that contain a given word within the lists of synonyms, antonyms, related or 
contrasted words, and idioms. For example, you might want to find all the entries containing the 
word intelligent, regardless of whether that word appears as a synonym, or a related or contrasted
word, or antonym of the main entry. This thesaurus search is equivalent to the "Defining text 
contains..." search in the dictionary.. 



 Rhyme searches
    Homophone searches



Etymology Searches in the Dictionary 

In a dictionary entry, the etymology provides information about the history and origin of a word. 
The Etymology includes... search allows you to look for words by their language of origin or by 
their non-English root word.    For example, you could find all of the words in the dictionary that 
originated in Japanese or that derived from the Greek root logia. 

Note that non-English root words within etymologies may not have their own entries in this 
dictionary.    As a result, you cannot see an entry for a foreign-language root word (such as the 
Old High German kuoli, which appears in the etymology at the entry for cool).    Brief definitions
for such foreign words are given in the etymologies where they occur. 

To learn more about how etymologies are structured, see the section titled  "The Etymology" in 
the PDF named  "Collegiate Dictionary Explanatory Notes"  on the CD-ROM. 

To do an etymology search, choose the Etymology includes... option from the Search Type 
drop-down menu, type the language name or root word you want to use in your search, then click
Search or press ENTER/RETURN. 
 
TIP: 
If the language name you want to search consists of two or more words, such as Middle English 
or Old High German, use the Advanced Searches tab to set up a multiple-term search. See the 
section Using the Advanced Searches Tab for more information. 



Word game searches 

If you like to solve word puzzles or if you enjoy creating them, the word game searches in this 
program will prove invaluable. You can do searches that will help you create or solve 
crosswords, jumbles, or cryptograms. The following sections provide more details about how to 
conduct word game searches. 
      Crossword puzzle searches
      Jumble searches
      Cryptogram searches



Searching for special information in dictionary or thesaurus entries 

Dictionary and thesaurus entries include a wealth of special information. You can use the special 
search features of this program to locate words by their part of speech, by the geographical 
region in which they are most often used, or by their special usage restrictions. You can also 
search for paragraphs that describe how synonyms are similar and distinct from each other, or 
you can look for paragraphs discussing words of confused or disputed usage. The following 
sections explain how to search for such information. 
      Function label searches in the dictionary or thesaurus
      Usage label/note searches in the dictionary
      Verbal Illustration searches in the dictionary or thesaurus
      Authors Quoted searches in the dictionary
      Synonym paragraph searches in the dictionary
      Usage paragraph searches in the dictionary



Using the Browse Tab 

Many dictionary and thesaurus lovers enjoy just browsing through the lists of words for an 
interesting one that catches their eye. Others find browsing helpful when they are trying to locate
a word where they perhaps don't recall the exact spelling or they will simply "know it when they 
see it." The Browse tab enables such a "scan the list" search technique through the Entry word 
starts with... and Entry word ends with... search options. 

The Browse tab includes two search options, Entry word starts with... and Entry word ends 
with.... The first allows you to find words that begin with certain letters; the latter lets you find 
words that end with a particular set of letters. 

To start using the Browse tab, follow these steps: 
    1.      Click on the Browse tab or choose

Browse from the View menu.
    2.      Choose one of the two search types from

the Search Type drop-down menu.
    3.      Type the letters that either begin or end the

entries you want to browse.
    4.      Click Search or press ENTER/RETURN.
    5.      Scan the Results List for the word you want.

Click on the word to see its entry.

For example, suppose you wanted to browse the section of the dictionary beginning with the 
letters ind. After selecting the Browse tab and Entry word starts with..., type ind in the input 
box, then click Search. The program will return a list of terms beginning with ind including 
indaba, indeed and indefatigable, along with other words that start with ind. 

The Browse tab also includes the Entry word starts with... search option, which is likely to be 
useful to poets and lyricists, those comparing the structure of words with similar spellings, or 
those creating word riddles. It allows you to search for a list of words that all end with the same 
set of letters. To use it, follow the steps listed above, but choose the Entry word starts with... 
option from the Search Type drop-down menu. 

For example, you might want to find all the words in the dictionary that end in the letters ede. 
After selecting the Browse tab and Entry word ends with..., type ede in the input box and click 
Search. The program will return a list of terms, including accede, centipede, precede, and other 
words that end with those letters    

All searches run in the Browse tab return a maximum of 300 entries in the Results List.



Using the Advanced Searches Tab 

Introduction to the Advanced Searches Tab
Setting Up Advanced Searches
Logical Connectors in Advanced Searches
Using Wildcard Characters
Parentheses in Searches
Searching for Inflected Forms
Example searches



Setting Up Advanced Searches 

The first step in setting up any advanced search is to decide what kind of information you want 
to find. Do you need a list of nouns that rhyme with the word name? Do you need a list of six-
letter words that start with "R" and include the term mammal in the definition? Do you want to 
find a all the dictionary entries that originated Latin and include either the word law or legal in 
their definition? 

Once you have determined what you want to find, you can build your search. To do so, follow 
these steps: 
    1.      Choose a search type (e.g., Defining text

contains...) from the Search Type drop-down menu.

    2.      Type the word or label you want to search
for (e.g., baseball).

    3.      Click Add.

    4.      Click on the appropriate logical connector
(i.e., AND, OR, NOT).

    5.      Choose another search type (e.g. Function
label is...).

    6.      Type the next word or label you want to search
for (e.g., noun).

    7.      Click Add.

    8.      Repeat step 5-7 until you have entered all of
the terms and search types you want into the search
display box on the screen. Be sure to end with a
search item (not a logical connector or parenthesis).

    9.      When you have added all of your search terms,
click Search or press ENTER/RETURN.

 
TIP: 
If you are not sure which search type to use to find particular information, check the PDF on the 
CD-ROM named  "Collegiate Dictionary Explanatory Notes" for more details about where to 
find certain kinds of information in the dictionary. 



Logical Connectors in Advanced Searches 

Logical connectors, also known as Boolean operators, help you construct searches to find words 
that match two or more specific criteria. For instance, you might want to find all of the dictionary
entries that whose definitions include both the words red and flower. In that case, you would use 
the connector AND to join the two words in your search. Or you might want to find all 
definitions containing either the word health or the word fitness. In that case, you would use the 
connector OR. In another situation, you might want to find all definitions including the word 
orange, but that refer to the fruit and not to the color. In that situation, you would use both the 
AND and the NOT connectors. 

The table below summarizes the three logical connectors that are used in this program.

 
 
TIP: 
Note that the NOT operator must be used immediately after the AND connector. If you try to use 
NOT by itself or after the OR connector, your search will almost always generate invalid results. 



Wildcard Characters 

You can use wildcard characters in any of the three search tabs, but they are especially useful in 
the Advanced Searches tab. Wildcard characters can help you look up words when you aren't 
sure how to spell them or when you want to find words that have a group of letters in common.    
The two wildcard characters available in this program are summarized below: 

 

For example, a search for m?n in the Entry word is... field will find man and men, as well as the 
abbreviations min, mon, mtn, and mun.    A search for m*n will find those entries, plus macaroon,
magnification, maiden, maintain, and many other words that begin with m and end with n. 

Note that you cannot use wildcard characters alone; they must always be used in combination 
with letters or numbers. 
 
WARNING! 
Searches with wildcards can produce very large results lists that may take a long time to display. 



Parentheses in Searches 

In advanced searches, you can use parentheses to group search criteria that belong together.    For
example, you might want to find all nouns that are labeled slang or nonstandard.    You might 
think that the following search request would find such words: 

Usage note=slang 
|
Usage=nonstandard
&
Function=noun

But those search instructions instead find all words that are labeled slang and all words that are 
labeled both nonstandard and noun. 

To find the words you really want, you must use parentheses to tell the computer the order in 
which to conduct its search.    To clarify the search example above, use parentheses around the 
OR statement, as shown below. 

(
Usage=slang
|
Usage=nonstandard
)
&
Function=noun
A

 
TIP: 
When you use parentheses in a search, click the buttons to add them on their own line in the 
search display box, as shown in the examples above. Do NOT include parentheses on the same 
line as the word or phrase you type into the program. 



Searching for Inflected Forms 

An inflected form of a word is a form that shows the case, number, gender, tense, or other 
grammatical distinction of the word.    For example, the plural of a noun and the past tense of a 
verb are inflected forms. 

For more about inflected forms, see the section  "Inflected Forms" in the PDF named  
"Collegiate Dictionary Explanatory Notes" on the CD-ROM.) 

If you try to look up an inflected form of a word, the program will automatically display the 
main entry that is the basis for the inflected form.    As a result, if you look up the plural flowers, 
the program will display the entry for flower, the appropriate singular form. This special search 
capability works in most cases, but there may be times when you will try to find a valid regular 
inflected form and the program will fail to recognize it. In such cases the program will 
automatically display a Lookup List in the Results/Lookup List area showing entries that fall 
alphabetically close to the inflected form you have typed.    You will probably see the base form 
of your search word near the top of the list, although occasionally you may have to scroll through
the list to find the word you want.



Example searches 

The following example searches will give you a chance to build some actual advanced searches 
to familiarize yourself with the process of creating them. They will be most effective if you print 
them out and complete each step in the program as you read along. 

The following examples involve advanced searches in the dictionary, but advanced search 
capabilities are also available in the thesaurus. 
 
Finding a list of nouns that rhyme with name:    
To find a list of nouns that rhyme with name, you will need to search for all the words that have 
the function label noun (use the "Function label is..." search) and that rhyme with name (use the 
"Rhymes with..." search). To complete this search, follow these steps: 
    1.      From the Search Type drop-down menu,

choose "Function label is...".

    2.      Type noun.

    3.      Click Add.

    4.      Click AND.

    5.      From the Search Type drop-down menu,
choose "Rhymes with...".

    6.      Type name.

    7.      Click Add.

    8.      Click Search.

The Results List should include 106 terms, starting with acclaim and ending with war-game. 
 
Finding six-letter words that start with "R" and include mammal in the definition:    
To find a list of six-letter words that start with "R" and include mammal in the definition (for 
instance, if you were solving a crossword puzzle and knew the number of letters and clue you 
needed for a particular term), you will need to do a crosswords search for words that have 
mammal in their defining text. To complete this search, follow these steps: 



    1.      From the Search Type drop-down menu,
choose "Forms a crossword of...".

    2.      Type r????? (the letter R followed by five
question marks, one for each unknown letter).

    3.      Click Add.

    4.      Click AND.

    5.      From the Search Type drop-down menu,
choose "Defining text contains...".

    6.            Type mammal.

    7.            Click Add.

    8.            Click Search.

The Results List should include 3 terms.



Introduction to the Advanced Searches Tab 

The Advanced Searches tab lets you create and run sophisticated searches to find very precise 
information. Using this tab, you can search for words that meet two or more specific criteria (for 
instance, all the words the originated in French and that include a form of the word cooking in 
their definition). The tab provides access to specialized search tools, such as logical 
connectors(also known as Boolean operators, e.g., AND, OR, NOT) and parentheses to aid you 
in creating complex searches. 

To access the program's advanced search options, click on the Advanced Searches tab by 
clicking on it on the main program screen or choose Advanced Searches from the View menu. 
 
TIP: 
The table Types of searches offers a handy quick-reference list of searchable fields in the 
dictionary and thesaurus. You may find it useful to keep that list table open as you create your 
first few searches on the Advanced Searches tab. 



Using Dictionary and Thesaurus Entries 

Listening to audio pronunciations
Printing
Highlighting and copying text
Pasting text into a field
Accessing the dictionary or thesaurus from other programs



Listening to audio pronunciations 

More than 100,000 entries in Merriam-Webster's Collegiate Dictionary are linked to audio files 
that enable you to hear the most commonly used pronunciation(s) of a word. When a word has 
more than one widely used and accepted pronunciation (e.g., economic), multiple pronunciations 
may be included. All pronunciations are recorded human voices, not synthesized speech, to 
provide the most natural possible reproduction of words as they are spoken. 

All dictionary entries that have audio will appear highlighted in blue. Double-click on a blue-
highlighted word to hear its associated audio pronunciation(s). 

NOTE: You must have the CD-ROM in the drive or you must copy the entire sound database 
(sound.cmp) to your hard drive to hear the audio pronunciations. You must have at least 600 MB 
of available disk space to copy the sound database to your hard drive. When you install the 
program, you will be given the option of placing the audio files on your hard drive. If you choose
to install the audio at a later time, you can do so by coping the files sound.cmp and sound.ndx 
from the CD-ROM into the directory Merriam-Webster > Books > C10.



Printing 

In this program, you can print entries, illustrations, tables, or Results Lists. To print, click the 
printer icon in the window containing the entry, list, illustration, or table. If you prefer to start 
printing using keyboard commands, you can access options to print each of those types of 
information by choosing Print from the File menu. To modify your printer settings, click on the 
Print Setup option in the File menu.



Highlighting and copying text 

You can highlight any words, phrases, or definitions within an entry by dragging over the text 
with your mouse. To quickly highlight all of the text in an entry, choose Select All from the Edit 
menu. To eliminate highlighting, click in any white space in the entry text display pane. 

Once text is highlighted, you can copy it and paste it into a text processing application, such as a 
word processor or your e-mail program. To copy highlighted text, either select Copy from the 
Edit menu or press CTRL + C. To paste the text you have copied into your text processing 
program, use that program's paste feature (it is usually under the Edit menu). 

In some cases, you may want to copy just the single word you looked up and use that in text you 
are writing. The Copy Word feature makes it easy to do so. After you have looked up a word, 
simply choose Copy Word from the Edit menu. 
 
WARNING! 
Special symbols or characters may be lost during copying and pasting because of the limitations 
of the clipboard feature your computer's operating system uses in copying. 



Pasting text into a field 

If you wish, you can copy a word from another program and paste it into the input box of the 
dictionary or thesaurus. Use the copy feature of the other program, then return to this program 
and choose Paste from the Edit menu. The word you copied will be pasted into the search input 
box; to then look up that word, click Search.



Accessing the dictionary or thesaurus from other programs 

Have you ever been writing a report or letter and reached a point where you weren't sure that you
had chosen the right word or that you were using a word correctly? In such instances, you want 
to check the word in the dictionary or thesaurus. Merriam-Webster's Collegiate Dictionary & 
Thesaurus includes macros that allow you to move quickly between your word processor and 
your dictionary or thesaurus. 

Macros are small companion programs included with this program to make it easy to look up 
words from within your word processor. The macros included in this program allow you to put a 
dictionary lookup button on the toolbar of Microsoft(R) Word for Windows 97, 2000, or XP. 
Macros are also available for Microsoft(R) Word for Macintosh 98, 2000 and X. 

During installation, Merriam-Webster's software should automatically detect which version of 
MS Word you have. If Word is detected, you can choose where to install the macro (i.e., in the 
toolbar, right-click menu, or both); you may also elect not to install any macros. If the installer 
cannot find a compatible word processor, a screen will appear asking you to indicate where your 
word processor is installed. 

Consult the documentation that came with your word processor to determine where its program 
files are installed. 

To use a macro after it has been installed, follow these steps: 
    1.      Open your word processing program.

    2.      Type a word and place the cursor in it.

    3.      Click the    macro button or right click menu listing.

The macro should automatically highlight and copy the word, open the dictionary/thesaurus 
program, and look up that word in whichever reference you have chosen as the reference (i.e., 
whichever one you have set to open first when you launch the program). 

If you decide you want to add the macros after installing the program itself, you can manually 
install the macro of your choice from the CD. To manually install a macro, insert the CD into the 
appropriate drive of your computer, locate the folder named "Macros," find the macro for your 
word processor, and double-click on it. Follow the on-screen instructions to complete the 
installation. 

NOTE: These macros are designed to work with the English-language alphabet and may not 
operate properly with non-English character sets. 

If you use Corel WordPerfect 10 and you would like to add a button to the WordPerfect toolbar 
which sets up a quick link between WordPerfect and your Merriam-Webster's reference, follow 



these instructions: 
      1.      In WordPerfect 10, choose Settings from the Tools menu.

      2.      Click the Customize button.

      3.      In the Customize box, click Edit.

      4.      In the Toolbar Editor box, click the Programs tab.

      5.      Click the Add Program button.

      6.      Navigate to the folder containing Merriam-Webster.exe and click on it.

      7.      Click the Open button.

      8.      Click OK.

      9.      Click Close.

    10.      Click Close again.



The Appearance tab is used to change text or background colors or to increase or decrease the 
size of the font used in dictionary and thesaurus entries. 

To change the color of the text or the background on it displays, click the appropriate Change 
button on the Appearance tab, choose the color you want, and click OK. 

To increase or decrease the size of the text, choose a text size from the drop-down menu on that 
tab. If you want to use the same colors and font sizes in the Results List, click the check box at 
the bottom of the tab. 
 
TIP: 
To return to the colors and text sizes that were used when you first installed this program (i.e., 
the default settings), click the Restore Defaults button. 



The Reference tab is used to select which reference will open when you start the program. 
Merriam-Webster's Collegiate DictionaryIf is chosen by default. If you prefer, you can use the 
drop-down menu on the Reference tab of the Preferences dialog have the thesaurus (or another 
Merriam-Webster reference, if installed) open first on launch. 
 



The Browse Search tab is used to select which tab (Basic, Advanced, or Browse) appears first 
when you open the progra. You can also use this tab in the Preferences dialog to set which type 
of search (e.g., search for entry words, search through definition text, search for words that 
rhyme) is preselected when you start the program. 
 
You can change or override preference settings at any time either by choosing a different option 
for the Select a Reference or Search Type drop-down menus or by choosing Edit . . . 
Preferences again.



Rhyme searches 

The Rhymes with... search type takes advantage of pronunciation information in dictionary 
entries to let you search for words that rhyme with    the word you type into the Search Input 
box. This feature is especially useful for poetys, lyricists, word-game players, students, and many
others who regularly use a rhyming dictionary while writing. For example, a Rhymes with... 
search for the word name will produce a Results List that includes acclaim, fame, and other 
words that rhyme with name. 

To do a rhyme search, choose the Rhymes with... option from the Search Type drop-down 
menu, type the word or phrase you want to find rhymes for, then click Search or press 
ENTER/RETURN.



Homophone searches 

The Homophones are... search type helps you find words that sound alike, but that are often 
spelled differently. Such words are called homophones. For example, to, too, and two are 
homophones. 

To do a homophone search, choose the Homophones are... option from the Search Type drop-
down menu, type the word or phrase you want to find rhymes for, then click Search or press 
ENTER/RETURN.



Crossword puzzle searches 

Crossword puzzle lovers know how frustrating it can be to be stuck with just one or two letters 
filled in in a word, unable to determine the missing letters to complete the puzzle. The Forms a 
crossword of... search can help you out of such a jam. 

In a Forms a crossword of... search, you type the letters you know and use the question mark 
wildcard symbol ? to represent letters you don't know.    The program will find a list of words 
that could represent the one you need.    For example, if you do a crosswords search for f??ta???,
you can obtain a list of the eight-letter-words that start with the letter F and have the letters T and
A in the fourth and fifth positions. 

To conduct a crosswords search, select the Forms a crossword of... option from Search Type 
drop-down menu, type the letters you know and type question marks to represent the letters you 
don't know, then click Search or press ENTER/RETURN. 
 
TIP: 
On the Advanced Searches tab, you can combine a crossword search with a defining text search 
to look for words with have the correct number of letters for your puzzle and that match its clue. 
See the section Using the Advanced Searches Tab for more information. 



Jumble searches 

Jumbles are also called anagrams, transposals, or transpositions. These popular word puzzles 
are mixed up words, and the puzzler's task is to unscramble the letters to make a word that 
matches a given clue. The Is a jumble of...search option in this program can making solving 
such puzzles (or creating new ones) a snap. For example, if you do an Is a jumble of...search
for lmies, the Results List will include words such as smile, limes, miles, and slime that can be 
made from those letters. 

To conduct a jumble search, select the Is a jumble of... option from Search Type drop-down 
menu, type the letters in your jumble, then click Search or press ENTER/RETURN.



Cryptogram searches 

Cryptograms are cipher puzzles in which each letter in a word is replaced by a different letter to 
create a coded word or message (for instance, xyzzdw is a cryptogram of hidden). The puzzler 
must find the correct letters to crack the code and make a logical message out of the cipher. The 
Is a cryptogram of... search is designed to make solving (or creating) cryptograms easier. 

To conduct a cryptogram search, select the Is a cryptogram of... option from Search Type drop-
down menu, type the letters in your coded cryptogram, then click Search or press 
ENTER/RETURN. 
 
TRY IT: 
Here's an example of a cryptogram: xyzzy. Which words might this cryptogram represent? 



Function label searches in the dictionary or thesaurus 

In Merriam-Webster's Collegiate Dictionary and Merriam-Webster's Collegiate Thesaurus, 
function labels are used to indicate how a word typically functions in a sentence. In most cases, 
the function label is a part of speech, such as noun, verb, adjective, adverb, pronoun, preposition,
or interjection. In some cases, however, the function label may indicate that a word is a 
trademark or certification mark.

For more information on function labels, see the section  "Functional Labels" in the PDF named 
"Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

To search for a word by its part of speech or other function label in either the dictionary or 
thesaurus, select the Function label is... option from Search Type drop-down menu, type the 
label you want to search for (e.g., pronoun, prefix), then click Search or press 
ENTER/RETURN. 
 
TRY IT: 
Choose Function label is... from the Search Type drop-down menu and type interjection to find 
some colorful ways to express impatience, annoyance, surprise, or delight. 

 
WARNING! 
Function field searches for very common parts of speech, such as noun, will bring back 
thousands of entries. Unless your computer has a lot of RAM, the number of entries returned 
may be so large that your computer will run out of memory and will not be able to display the 
entire list. In some cases, your computer may even freeze trying to retrieve huge word lists. To 
avoid this problem, avoid searching for very common parts of speech. Instead, make your search 
more specific using the Advance Searches tab. See the section Using the Advanced Searches Tab 
for more information. 



Usage label/note searches in the dictionary 

You can use the Usage note contains... search to look for all dictionary entries that carry usage 
notes or labels (that is, brief messages indicating the words are used in a certain way, for 
instance, that they are slang or nonstandard). You can also search for words used primarily in a 
certain geographic area (e.g., Scotland, chiefly Northern) or in a particular subject area (e.g., 
basketball, law, physics). 

For more information on usage labels, see the section named "Usage Notes" in the PDF titled  
"Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

To search for a word by its usage note or label, select the Usage note contains... option from 
Search Type drop-down menu, type the label you want to search for (e.g., slang, British), then 
click Search or press ENTER/RETURN. 
 
TIP: 
If you don't get the results you expect in a Usage note search, try searching in the defining text; 
some usage labels or notes may are included within definitions or individual senses. 



Verbal Illustration searches in the dictionaryor thesaurus 

Often, you can gain a better understanding of what a word means by seeing it used in context. 
Merriam-Webster's Collegiate Dictionary and Merriam-Webster's Collegiate Thesaurus include 
thousands of example sentences, phrases, and quotations showing how words are commonly 
used. Those examples or words used in context are called verbal illustrations. 

This program allows you to search for verbal illustrations even when they do not appear at the 
entry word you are studying. For example, you might want to see examples of the word distinct 
used in context. That word appears in verbal illustrations for words such as definition and 
evidence. You can readily find all such examples through a verbal illustration search. 

For more information about verbal illustrations, see the section "Verbal Illustrations" in the PDF 
named "Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

To perform a verbal illustration search, select the Verbal Illustration contains... option from 
Search Type drop-down menu, type the word you want to see demonstrated, then click Search 
or press ENTER/RETURN.



Authors Quoted searches in the dictionary 

You can use an Author quoted is... search to locate quotations by an author whose work was 
used to provide examples of words used in context. Authors quoted searches always involve 
searching for the last name of the author. So if you were seeking quotations by William 
Shakespeare, you would search for Shakespeare; if you were seeking quotations by Pearl Buck, 
you would search for Buck. 

Do not include first names, initials, or courtesy titles such as Dr. or Ms. in an Author quoted is...
search. Always capitalize the author's name or, if you are searching for quotations from a 
particular publication, capitalize the key word from its title. 

To perform an author's quoted search, select the Author quoted is... option from Search Type 
drop-down menu, type the last name of the author or a key word in the title of the publication 
you are seeking, then click Search or press ENTER/RETURN. 

For more information about authors quoted in the dictionary, see the section named  "Authors 
Quoted" in the PDF named  "Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

 
TIP: 
You can also find quotations from periodicals or newspapers by searching for a key word in the 
publication's title. For instance, if you wanted to find quotations from The New York Times, you 
could do an authors quoted search for Times. 
To perform an authors quoted search, select the Author quoted is... option from Search Type 
drop-down menu, type the word you want to see demonstrated, then click Search or press 
ENTER/RETURN.



Synonym searches in the dictionary 

A number of entries in the dictionary include brief paragraphs, called synonymy paragraphs, that 
discuss the similarities and differences between words of closely related meaning; these 
paragraphs can help you select the best word to use in a given situation. You can use the 
Synonym paragraph contains... search option to find such paragraphs. 

For more information about synonym paragraphs, see the section "Synonym Paragraphs" in the 
PDF named     "Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

To perform a synonym paragraph search, select the Synonym paragraph contains... option 
from Search Type drop-down menu, type the word for which you are seeking synonyms, then 
click Search or press ENTER/RETURN.



Usage paragraph searches in the dictionary 

Merriam-Webster's Collegiate Dictionary includes hundreds of paragraphs that provide 
information about and guidance on words whose usage is a subject of dispute or potential 
confusion. For example, there is a usage paragraph that provides information about the 
acceptability of the use of the word ain't.    

A usage paragraph typically summarizes the historical background of the usage of the word, and 
also provides and overview of opinions on it. Usage paragraphs may also compare commentary 
on the word with actual evidence of use, and many offer usage advice. You can use the Usage 
paragraph contains... search to find paragraphs that can help you make more informed choices 
about which word to use (or avoid) in particular contexts. 

For more information about usage paragraphs, see the section "Usage Paragraphs" in the PDF 
named  "Collegiate Dictionary Explanatory Notes" on the CD-ROM. 

To perform a usage paragraph search, select the Usage paragraph contains... option from 
Search Type drop-down menu, type the word for which you are seeking a usage paragraph, then 
click Search or press ENTER/RETURN.



You operate the help system by selecting items from the    help menu. 
Common operations include: 
- Searching for help
- Contextual help
- Keyboard help
- Click help
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The "Help On Context" menu item provides context dependant help. Help is retrieved according 
to location of the input focus within    an application.    Typically, controls or windows are 
highlighted in a    special (and object specific) manner; this shows the input focus. 
By pressing the help or F1 key, help is retrieved from the application help file for the currently 
focused object.



The search help menu item, and the "Search..." button in the help viewer both activate the topic 
search dialog. 
The search dialog is an easy way to see what topics are available within a help file, and to 
quickly activate a topic. 
You can search either by keyword, or in some cases by the help topic title.



This help item displays help for the current window.    



Object click help allows the selection of various application objects -- once an object is selected, 
help for that object is displayed in the help viewer.






